
Color y textura



¿Qué es el color?
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[Goethe, 1810]

“El color es producto de la luz a ciertas 
longitudes de onda”

“El color es producto de la percepción 
del observador”

[Newton, 1686]



Proceso de visión
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Measurements of 
relative spectral 
power of sunlight, 
made by J. Parkkinen 
and P. Silfsten.  
Relative spectral 
power is plotted 
against wavelength in 
nm.  The visible range 
is about 400nm to 
700nm.  The color 
names on the 
horizontal axis give 
the color names used 
for monochromatic 
light of the 
corresponding 
wavelength --- the 
“colors of the 
rainbow”.  Mnemonic 
is “Richard of York 
got blisters in 
Venice”.

Violet         Indigo Blue      Green             Yellow            Orange                 Red



¿Son de igual color los cuadrados pequeños?



¿Son de igual color los cuadrados A y B?



[File > Open Samples > Striped Circles]

¿De qué color son los círculos?



El ojo
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Fotoreceptores
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[Adaptado de https://upload.wikimedia.org/wikipedia/commons/c/c0/Eyesensitivity.svg]https://upload.wikimedia.org/wikipedia/commons/9/94/1416_Color_Sensitivity.jpg



Representación del color
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Experimentos de Wright (1928) y Guild (1931).



Representación del color

• El color es una característica de tres dimensiones. 

• Muchos colores pueden representarse como la mezcla de tres “colores primarios” A, 
B y C. 
• Adición: 

• Principio de tricromacia: con tres colores primarios se pueden generar otros colores 
(para la mayoría de las personas).
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D = waA+ wbB + wcC

D + waA = wbB + wcC ) D = �waA+ wbB + wcC

RGB (aditivo, luz) CMY(K) (sustractivo, pigmentos)



RGB

• Aditivo 

• Suma de tres luces sobre un papel. 

• Muy simple. Usado en computadoras, monitores, cámaras, scanners, teléfonos, … 
• Calibración para colorimetría. 

• No es ajustado para operaciones con colores (p.e. promedio colores).
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186 8. Color Images
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RGB Value
Point Color R G B

S Black 0.00 0.00 0.00
R Red 1.00 0.00 0.00
Y Yellow 1.00 1.00 0.00
G Green 0.00 1.00 0.00
C Cyan 0.00 1.00 1.00
B Blue 0.00 0.00 1.00
M Magenta 1.00 0.00 1.00
W White 1.00 1.00 1.00
K 50% Gray 0.50 0.50 0.50

R75 75% Red 0.75 0.00 0.00
R50 50% Red 0.50 0.00 0.00
R25 25% Red 0.25 0.00 0.00
P Pink 1.00 0.50 0.50

Figure 8.1 Representation of the RGB color space as a three-dimensional unit cube. The
primary colors red (R), green (G), and blue (B) form the coordinate system. The “pure” red
color (R), green (G), blue (B), cyan (C), magenta (M), and yellow (Y) lie on the vertices of
the color cube. All the shades of gray, of which K is an example, lie on the diagonal between
black S and white W.

three beams of light—one red, one green, and one blue—on a sheet of white pa-
per. To create different colors, you would modify the intensity of each of these
beams independently. The distinct intensity of each primary color beam con-
trols the shade and brightness of the resulting color. The colors gray and white
are created by mixing the three primary color beams at the same intensity. A
similar operation occurs on the screen of a color television or CRT1-based com-
puter monitor, where tiny, close-lying dots of red, green, and blue phosphorous
are simultaneously excited by a stream of electrons to distinct energy levels
(intensities), creating a seemingly continuous color image.

The RGB color space can be visualized as a three-dimensional unit cube in
which the three primary colors form the coordinate axis. The RGB values are
positive and lie in the range [0, Cmax]; for most digital images, Cmax = 255.
Every possible color Ci corresponds to a point within the RGB color cube of
the form

Ci = (Ri, Gi, Bi),

where 0 ≤ Ri, Gi, Bi ≤ Cmax. RGB values are often normalized to the interval
[0, 1] so that the resulting color space forms a unit cube (Fig. 8.1). The point
S = (0, 0, 0) corresponds to the color black, W = (1, 1, 1) corresponds to the
color white, and all the points lying on the diagonal between S and W are
shades of gray created from equal color components R = G = B.

Figure 8.2 shows a color test image and its corresponding RGB color com-
ponents, displayed here as intensity images. We will refer to this image in a
1 Cathode ray tube.

Ci = (Ri, Gi, Bi)



8.2 Color Spaces and Color Conversion 203

(a)

(b)
RGB

Figure 8.9 Examples of the color distribution of natural images. Original images: landscape
photograph with dominant green and blue components and sun-spot image with rich red and
yellow components (a). Distribution of image colors in RGB-space (b).

Those recommended in ITU-BT.709 [20] for digital color encoding are

wR = 0.2125 , wG = 0.7154 , wB = 0.072 . (8.7)

If each color component is assigned the same weight, as in Eqn. (8.4), this is of
course just a special case of Eqn. (8.5).

Note that, although these weights were developed for use with TV sig-
nals, they are optimized for linear RGB component values, i. e., signals with
no gamma correction. In many practical situations, however, the RGB compo-
nents are actually nonlinear, particularly when we work with sRGB images (see
Vol. 2 [6, Sec. 6.3]). In this case, the RGB components must first be linearized
to obtain the correct luminance values with the above weights. An alternative
is to estimate the luminance without linearization by computing the weighted
sum of the nonlinear component values and applying a different set of weights
(for details see p. 109 of Vol. 2 [6, Sec. 6.3]).

[Plugins > Color Inspector 3D]



Color inspector
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[Plugins > Color Inspector 3D]



Tipos de imágenes RGB
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8.1 RGB Color Images 189
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Figure 8.3 RGB color image in component ordering. The three color components are laid
out in separate arrays IR, IG, IB of the same size.
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Figure 8.4 RGB-color image using packed ordering. The three color components R, G, and
B are placed together in a single array element.

The access functions, Red(), Green(), Blue(), will depend on the specific imple-
mentation used for encoding the color pixels.

Indexed images

Indexed images permit only a limited number of distinct colors and therefore
are used mostly for illustrations and graphics that contain large regions of the
same color. Often these types of images are stored in indexed GIF or PNG files
for use on the Web. In these indexed images, the pixel array does not contain
color or brightness data but instead consists of integer numbers k that are used
to index into a color table or “palette”

P (k) = (rk, gk, bk) ,

for k = 0 . . .N−1 (Fig. 8.5). N is the size of the color table and therefore also
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190 8. Color Images
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Figure 8.5 RGB indexed image. Instead of a full color value, each pixel in Iidx(u,v) contains
an index k. The color value for each k is defined by an entry in the color table or “palette”
P [k].

the maximum number of distinct image colors (typically N = 2 to 256 ). Since
the color table can contain any RGB color value (rk, gk, bk), it must be saved
as part of the image. The RGB component values of an indexed image Iidx at
location (u, v) are obtained as

⎛

⎝
R
G
B

⎞

⎠←

⎛

⎝
PR(k)
PG(k)
PB(k)

⎞

⎠ =

⎛

⎝
rk

gk

bk

⎞

⎠ , with k = Iidx(u, v). (8.3)

During the transformation from a true color image to an indexed image (for
example, from a JPEG image to a GIF image), the problem of optimal color
reduction, or color quantization, arises. Color quantization is the process of
determining an optimal color table and then mapping it to the original colors.
This process is described in detail in Vol. 2 [6, Sec. 5].

8.1.2 Color Images in ImageJ

ImageJ provides two simple types of color images:

– RGB full-color images (24-bit “RGB color”)

– Indexed images (“8-bit color”)

RGB true color images

RGB color images in ImageJ use a packed order (see Sec. 8.1.1), where each
color pixel is represented by a 32-bit int value. As Fig. 8.6 illustrates, 8 bits
are used to represent each of the RGB components, which limits the range of
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Vol. 2 [6, Sec. 6].

8.1.1 Organization of Color Images
Color images are represented in the same way as grayscale images, by using
an array of pixels in which different models are used to order the individual
color components. In the next sections we will examine the difference between
true color images, which utilize colors uniformly selected from the entire color
space, and so-called palleted or indexed images, in which only a select set of
distinct colors are used. Deciding which type of image to use depends on the
requirements of the application.

True color images

A pixel in a true color image can represent any color in its color space, as long
as it falls within the (discrete) range of its individual color components. True
color images are appropriate when the image contains many colors with sub-
tle differences, as occurs in digital photography and photo-realistic computer
graphics. Next we look at two methods of ordering the color components in
true color images: component ordering and packed ordering.

Component ordering. In component ordering (also referred to as planar
ordering) the color components are laid out in separate arrays of identical
dimensions. In this case, the color image

I =
(
IR, IG, IB

)

can be thought of as a vector of related intensity images IR, IG, and IB

(Fig. 8.3), and the RGB component values of the color image I at position
(u, v) are obtained by accessing all three intensity images as follows:

⎛

⎝
Ru,v

Gu,v

Bu,v

⎞

⎠←

⎛

⎝
IR(u, v)
IG(u, v)
IB(u, v)

⎞

⎠ . (8.1)

Packed ordering. In packed ordering, the component values that represent
the color of a particular pixel are packed together into a single element of the
image array (Fig. 8.4) so that

I(u, v) = (Ru,v, Gu,v, Bu,v).

The RGB value of a packed image I at the location (u, v) is obtained by ac-
cessing the individual components of the color pixel as

⎛

⎝
Ru,v

Gu,v

Bu,v

⎞

⎠←

⎛

⎝
Red(I(u, v))

Green(I(u, v))
Blue(I(u, v))

⎞

⎠ . (8.2)
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Conversión a escala de grises

• Imagen con el “equivalente” en grises o la “luminancia” Y.  

• No hay una única forma 
• La más simple (pero mala)  

• La percepción de los canales no es la misma 

• Promedios ponderados
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Y = R+G+B
3

Y = wRR+ wGG+ wBB

202 8. Color Images

colors within the RGB space, it is important to remember that the metric, or
measured distance within this color space, does not proportionally correspond
to our perception of color (e. g., doubling the value of the red component does
not necessarily result in a color which appears to be twice as red). In general,
in this space, modifying different color points by the same amount can cause
very different changes in color. In addition, brightness changes in the RGB
color space are also perceived as nonlinear.

Since any coordinate movement modifies color tone, saturation, and bright-
ness all at once, color selection in RGB space is difficult and quite non-intuitive.
Color selection is more intuitive in other color spaces, such as the HSV space
(see Sec. 8.2.3), since perceptual color features, such as saturation, are rep-
resented individually and can be modified independently. Alternatives to the
RGB color space are also used in applications such as the automatic separation
of objects from a colored background (the blue box technique in television),
encoding television signals for transmission, or in printing, and are thus also
relevant in digital image processing.

Figure 8.9 shows the distribution of the colors from natural images in the
RGB color space. The first half of this section introduces alternative color
spaces and the methods of converting between them and later discusses the
choices that need to be made to correctly convert a color image to grayscale.
In addition to the classical color systems most widely used in programming,
precise reference systems, such as the CIEXYZ color space, gain increasing
importance in practical color processing.

8.2.1 Conversion to Grayscale
The conversion of an RGB color image to a grayscale image proceeds by com-
puting the equivalent gray or luminance value Y for each RGB pixel. In its
simplest form, Y could be computed as the average

Y = Avg(R, G, B) =
R + G + B

3
(8.4)

of the three color components R, G, and B. Since we perceive both red and
green as being substantially brighter than blue, the resulting image will appear
to be too dark in the red and green areas and too bright in the blue ones.
Therefore, a weighted sum of the color components

Y = Lum(R, G, B) = wR ·R + wG ·G + wB ·B (8.5)

is typically used to compute the equivalent luminance value. The weights most
often used were originally developed for encoding analog color television signals
(see Sec. 8.2.4):

wR = 0.299 , wG = 0.587, wB = 0.114. (8.6)

8.2 Color Spaces and Color Conversion 203

(a)

(b)
RGB

Figure 8.9 Examples of the color distribution of natural images. Original images: landscape
photograph with dominant green and blue components and sun-spot image with rich red and
yellow components (a). Distribution of image colors in RGB-space (b).

Those recommended in ITU-BT.709 [20] for digital color encoding are

wR = 0.2125 , wG = 0.7154 , wB = 0.072 . (8.7)

If each color component is assigned the same weight, as in Eqn. (8.4), this is of
course just a special case of Eqn. (8.5).

Note that, although these weights were developed for use with TV sig-
nals, they are optimized for linear RGB component values, i. e., signals with
no gamma correction. In many practical situations, however, the RGB compo-
nents are actually nonlinear, particularly when we work with sRGB images (see
Vol. 2 [6, Sec. 6.3]). In this case, the RGB components must first be linearized
to obtain the correct luminance values with the above weights. An alternative
is to estimate the luminance without linearization by computing the weighted
sum of the nonlinear component values and applying a different set of weights
(for details see p. 109 of Vol. 2 [6, Sec. 6.3]).

8 bits Lab RGB LuminanceOriginal RGB Y = R+G+B
3



HSB (Hue, Saturation, Brightness)

• RGB ⟷ HSB (HSV, HSI) 

• No lineal

 16
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HHSV SHSV VHSV

Figure 8.12 HSV components for the test image in Fig. 8.2. The darker areas in the hHSV
component correspond to the red and yellow colors, where the hue angle is near zero.

H
S

V

YG

C

B M

W

S

R

R75

R50

R25

P

RGB/HSV Values
Pt. Color R G B H S V

S Black 0.00 0.00 0.00 — 0.00 0.00
R Red 1.00 0.00 0.00 0 1.00 1.00
Y Yellow 1.00 1.00 0.00 1/61.00 1.00
G Green 0.00 1.00 0.00 2/61.00 1.00
C Cyan 0.00 1.00 1.00 3/61.00 1.00
B Blue 0.00 0.00 1.00 4/61.00 1.00
M Magenta 1.00 0.00 1.00 5/61.00 1.00
W White 1.00 1.00 1.00 — 0.00 1.00
R75 75% Red 0.75 0.00 0.00 0 1.00 0.75
R50 50% Red 0.50 0.00 0.00 0 1.00 0.50
R25 25% Red 0.25 0.00 0.00 0 1.00 0.25

P Pink 1.00 0.50 0.50 0 0.5 1.00

Figure 8.13 HSV color space. The illustration shows the HSV color space as a cylinder
with the coordinates H (hue) as the angle, S (saturation) as the radius, and V (brightness
value) as the distance along the vertical axis, which runs between the black point S and the
white point W. The table lists the (R, G, B) and (H, S, V ) values of the color points marked
on the graphic. Pure colors (composed of only one or two components) lie on the outer wall
of the cylinder (S = 1), as exemplified by the gradually saturated reds (R25, R50, R75, R).

completely across the cylinder’s base. Figure 8.12 shows the individual HSV
components (in grayscale) of the test image in Fig. 8.2. Figure 8.13 plots the
location of some notable color points and compares them with their locations
in RGB space (see also Fig. 8.1).

Java implementation. In Java, the RGB-HSV conversion is implemented in
the class java.awt.Color by the method

float[] RGBtoHSB (int r, int g, int b, float[] hsv )
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(a)

(b)
HSV

(c)
YUV

Figure 8.18 Examples of the color distribution of natural images in different color spaces.
Original images (a); color distribution in HSV- (b), and YUV-space (c). See Fig. 8.9 for the
corresponding distributions in RGB color space.



CIE L*a*b*

• Basado en un conjunto de colores base 
(imaginarios) CIE XYZ creados en 1931. 

• Uniformidad cercana a la percepción visual 
humana. 

• La distancia Euclidea entre dos colores es 
similar a la diferencia percibida entre ellos.  

• L* corresponde a la luminosidad, a* 
corresponde a la variación de tono-
saturación en el eje verde-rojo, y b* en el 
eje azul-amarillo.
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Chromaticity Diagram



Evolución de la representación del color

• Primera generación: colores físicos 
• RGB, XYZ, … 

• Segunda generación: psicovisión 
• CIE Lab, Munsell, … 

• Tercera generación: apariencia espacial del color 
• CAM, Retinex, ACE, …

 19

[Image> Color > Retinex]



Pseudo-color

• Uso de un mapa de colores (LUT) para la visualización de imágenes 
monocromáticas. 
• Mejor discernimiento de colores.

 20

6.3 ■ Pseudocolor Image Processing 419

FIGURE 6.22 (a) Gray-scale image in which intensity (in the lighter horizontal band shown) corresponds to
average monthly rainfall. (b) Colors assigned to intensity values. (c) Color-coded image. (d) Zoom of the
South American region. (Courtesy of NASA.)

Red
transformation

Green
transformation

Blue
transformation

fR(x , y )

fG(x , y )

fB(x , y )

f(x , y )

FIGURE 6.23
Functional block
diagram for
pseudocolor
image processing.

and are
fed into the
corresponding
red, green, and
blue inputs of an
RGB color
monitor.

fBfR, fG,

a b
c d



Textura





¿Qué es la textura?

• Concepto “alto nivel”. 
• Suavidad, áspero, regularidad, patrón repetitivo, … 

• Análisis basado en descriptores o características (features). 
• Estructural 

• Estadístico 

• Espectral

 23



Texturas estructurales y estadísticas

• Elementos de textura (texels) repetitivos. 
• Texel: el elemento gráfico más pequeño que crea la impresión de una superficie texturada.

 24

STRUCTURAL TEXTURES 

Repetitive Texture Elements (Texels) 

A texel represents the smallest graphical element in a 
two-dimensional texture that creates the impression of 
a textured surface.  

STATISTICAL TEXTURES 

Homogeneous Statistical Properties 

• Propiedades estadísticas homogéneas



Aplicaciones

• Clasificación: determinar el tipo (clase) a una nueva muestra 
• Segmentación: partir en regiones de textura similar 
• Síntesis: dada una muestra, generar otras de apariencia similar 
• Recuperación de pose y estructura

 25



Métricas estadísticas
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11.3 ■ Regional Descriptors 829

The third moment,

(11.3-7)

is a measure of the skewness of the histogram while the fourth moment is a
measure of its relative flatness. The fifth and higher moments are not so easily
related to histogram shape, but they do provide further quantitative discrimi-
nation of texture content. Some useful additional texture measures based on
histograms include a measure of “uniformity,” given by

(11.3-8)

and an average entropy measure, which, you will recall from basic information
theory, is defined as

(11.3-9)

Because the ps have values in the range [0, 1] and their sum equals 1, measure
is maximum for an image in which all intensity levels are equal (maximally

uniform), and decreases from there. Entropy is a measure of variability and is
0 for a constant image.

U

e(z) = -a
L-1

i=0
p(zi) log2 p(zi)

U(z) = a
L-1

i=0
p2(zi)

m3(z) = a
L-1

i=0
(zi - m)3p(zi)

EXAMPLE 11.10:
Texture measures
based on
histograms.

■ Table 11.2 summarizes the values of the preceding measures for the three
types of textures highlighted in Fig. 11.28.The mean just tells us the average in-
tensity of each region and is useful only as a rough idea of intensity, not really
texture. The standard deviation is much more informative; the numbers clear-
ly show that the first texture has significantly less variability in intensity levels
(it is smoother) than the other two textures.The coarse texture shows up clear-
ly in this measure. As expected, the same comments hold for because it
measures essentially the same thing as the standard deviation. The third mo-
ment generally is useful for determining the degree of symmetry of histograms
and whether they are skewed to the left (negative value) or the right (positive
value). This gives a rough idea of whether the intensity levels are biased to-
ward the dark or light side of the mean. In terms of texture, the information
derived from the third moment is useful only when variations between mea-
surements are large. Looking at the measure of uniformity, we again conclude

R,

Standard Third
Texture Mean deviation R (normalized) moment Uniformity Entropy

Smooth 82.64 11.79 0.002 0.026 5.434
Coarse 143.56 74.63 0.079 0.005 7.783
Regular 99.72 33.73 0.017 0.750 0.013 6.674

-0.151
-0.105

TABLE 11.2 
Texture measures
for the subimages
shown in Fig. 11.28.



Métricas estadísticas

• Los histogramas no tiene información de la posición de las intensidades, que es un 
aspecto clave para la textura. 

• Matriz de co-ocurrencia
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FIGURE 11.29
How to generate
a co-occurrence
matrix.

that the first subimage is smoother (more uniform than the rest) and that the
most random (lowest uniformity) corresponds to the coarse texture.This is not
surprising. Finally, the entropy values are in the opposite order and thus lead
us to the same conclusions as the uniformity measure did. The first subimage
has the lowest variation in intensity levels and the coarse image the most. The
regular texture is in between the two extremes with respect to both these
measures. ■

Measures of texture computed using only histograms carry no informa-
tion regarding the relative position of pixels with respect to each other. This
is important when describing texture, and one way to incorporate this type
of information into the texture-analysis process is to consider not only the
distribution of intensities, but also the relative positions of pixels in an
image.

Let be an operator that defines the position of two pixels relative to
each other, and consider an image, with possible intensity levels. Let G
be a matrix whose element is the number of times that pixel pairs with
intensities and occur in in the position specified by where

A matrix formed in this manner is referred to as a gray-level
(or intensity) co-occurrence matrix . When the meaning is clear, G is referred
to simply as a co-occurrence matrix .

Figure 11.29 shows an example of how to construct a co-occurrence matrix
using and a position operator defined as “one pixel immediately to
the right” (i.e., the neighbor of a pixel is defined as the pixel immediately to
its right). The array on the left is a small image under consideration and the
array on the right is matrix G. We see that element (1, 1) of G is 1, because
there is only one occurrence in of a pixel valued 1 having a pixel valued 1
immediately to its right. Similarly, element (6, 2) of G is 3, because there are
three occurrences in of a pixel with a value of 6 having a pixel valued 2 im-
mediately to its right. The other elements of G are computed in this manner.
If we had defined as, say, “one pixel to the right and one pixel above,” thenQ

f

f

QL = 8

1 … i, j … L.
Q,fzjzi

gij
Lf,

Q

Note that we are using
the intensity range 
instead of our usual

This is done
so that intensity values
will correspond with
“traditional” matrix in-
dexing (i.e., intensity
value 1 corresponds to
the first row and column
indices of G).

[0, L - 1].

[1, L]

Imagen Matrix de co-ocurrencia G



Métricas estadísticas

• Descriptores de la matriz de co-ocurrencia G
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FIGURE 11.31
co-

occurrence
matrices,
and
corresponding
from left to right
to the images in
Fig. 11.30.

G3,
G1, G2,

256 * 256

DescriptorNormalized
Co-occurrence Max 

Matrix Probability Correlation Contrast Uniformity Homogeneity Entropy

0.00006 10838 0.00002 0.0366 15.75
0.01500 0.9650 570 0.01230 0.0824 6.43
0.06860 0.8798 1356 0.00480 0.2048 13.58G3>n3

G2>n2

-0.0005G1>n1

TABLE 11.4 
Descriptors
evaluated using
the co-occurrence
matrices displayed
in Fig. 11.31.

images is the number of times that pixels pairs with intensities and occur 
in in the position specified by so it is not surprising that Fig. 11.31(a) is a
random image, given the nature of the image from which it was obtained.

Figure 11.31(b) is more interesting. The first obvious feature is the symme-
try about the main diagonal. Due to the symmetry of the sine wave, the num-
ber of counts for a pair is the same as for the pair which
produces a symmetric co-occurrence matrix. The non-zero elements of are
sparse because value differences between horizontally adjacent pixels in a
horizontal sine wave are relatively small. It helps to remember in interpreting
these concepts that a digitized sine wave is a staircase, with the height and
width of each step depending on frequency and the number of amplitude lev-
els used in representing the function.

The structure of co-occurrence matrix in Fig. 11.31(c) is more complex.
High count values are grouped along the main diagonal also, but their distrib-
ution is more dense than for a property that is indicative of an image with
a rich variation in intensity values, but few large jumps in intensity between
adjacent pixels. Examining Fig. 11.30(c), we see that there are large areas char-
acterized by low variability in intensities. The high transitions in intensity
occur at object boundaries, but these counts are low with respect to the mod-
erate intensity transitions over large areas, so they are obscured by the ability
of an image display to show high and low values simultaneously, as we dis-
cussed in Chapter 3.

The preceding observations are qualitative. To quantify the “content” of co-
occurrence matrices we need descriptors such as those in Table 11.3. Table 11.4
shows values of these descriptors computed for the three co-occurrence matrices

G2,

G3

G2

(zj, zi),(zi, zj)

Q,f
zjzi

a b c

1 2 3



Métricas espectrales

• Con la TF se detectan: 

• Picos dominantes asociados a 
direcciones principales de textura. 

• Tamaño (frecuencia) de las 
repeticiones espaciales. 

• Eliminando (filtrando) esas 
componentes dominantes queda la 
información no periódica que puede 
describirse con métricas estadísticas.
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• Basadas en la Transformada de Fourier o variantes como la DCT. 

• Ajustada para distinguir patrones repetitivos o periódicos. 

• Patrones globales.



Métricas basadas en filtros

• Representan la imagen a partir de la respuesta a un conjunto de filtros

 30

Conjunto de filtro de 
Gabor de diferente 
orientación y escala.



Reconocimiento de Patrones / Aprendizaje Automático



Pattern Recognition / Machine Learning
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Reconocimiento de patrones/Aprendizaje automático
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El Rcenomicietno ed 
Partoens es una dipscinila que 

etsduia mdéotos que premiten indefiticar 
ojbetos, tpios de obtejos o rcelaiones a 
ptarir de sñeales o dtaos del mduno 
cmoo udste hcae en etse mometno 

cno etsas paarblas.

“El estudio de cómo las 
máquinas pueden, 

observando el ambiente, 
aprender a distinguir patrones 

de interés de un fondo y 
realizar decisiones razonables 
sobre las categorías de los 

mismos.”

“El acto de tomar datos 
crudos y hacer una acción 

basados en la categoría de los 
patrones.”

“Descubrir automáticamente 
regularidades en los datos 

usando algoritmos en 
computadora y a partir de esas 

regularidades tomar 
acciones.”

aprendizaje: mejorar con la 
experiencia en una tarea

medida de 
desempeño

datos aplicación



Clasificador Etiqueta 
(clase, valor)

preprocesamiento

Sistema de reconocimiento de patrones
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preprocesamiento

datos 
entrenamiento 

+ 
etiquetas

Entrenamiento de 
modelo 

(aprendizaje)
Modelo

sensores, 
cámaras, 
bases, …

reducción de dimensiones, 
selección/extracción de 

características, …

clasificación, regresión, 
clustering, …

Validación 
del Modelo

datos 
test

datos 
validación

entrenamiento validación testDatos

extracción/
selección de 

características

extracción/
selección de 

características

pre-procesamiento, 
denoising, filtrado, 
normalización, …

x
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Categorías de los sistemas de RP
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reinforcement learning 
realimentación del resultado de la tarea: 

recompensa o penalización

supervisado 
datos de entrenamiento 
con etiquetas (clases) o 

valores de salida correctos 
para predecir datos nuevos

no supervisado 
no se conocen las  

etiquetas (clases) de los 
datos, se organizan a 

partir de las 
características.

semi-supervisado 
se conocen las  etiquetas 
(clases) de algunos datos

• clasificación y regresión 
• aprendizaje explícito 
• evaluación directa 
• predicción clase/valor 
• paramétrico o no

• identificación de patrones/
estructura 

• evaluación indirecta o 
cualitativa 

• organiza/agrupa clustering 
• paramétrico o no 
• # clases conocida o no

• aproximación a IA 
• definir estrategias ante eventos 
• maximizar recompensa

Nearest Neighbor, Support 
Vector Machines (SVM), 

Decision Trees, Random Forest, 
Discriminant Analysis, Naive 

Bayes, Neural Networks, Linear 
Regression, SVR, …

k-means, Fuzzy C-means, 
Hierarchical Clustering, Spectral 
Clustering, Gaussian Mixtures, 
Hidden Markov Model, Neural 

Networks, (Generalized/Robust) 
PCA, Isomap, MDS, Diffusion 

Maps, …



Medidas de desempeño
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TP: true positives, TN: true negatives, FP: false positives, FN: false negatives.
falsa alarma (error I) desacierto (error II)acierto rechazo correcto

Accuracy (exactitud):

Sensitivity/Recall (sensibilidad):

Precision (presición):

Specificity (especifidad):
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<latexit sha1_base64="oXbT6FHja3ovjDrv7pLA+hHCQIQ=">AAACLHicbVDLSgMxFE3qq9ZXa5dugkWoCHVGFN0IBUFcDVWmD2iHkknTNjTzIMkIw9Bvcasbv8aNiFu/w0w7C9t6IeFw7uMcjhtyJpVhfMLc2vrG5lZ+u7Czu7d/UCwdtmQQCUKbJOCB6LhYUs582lRMcdoJBcWey2nbndyl/fYzFZIFvq3ikDoeHvlsyAhWmuoXy7b1dGtb51b6VW3r7L5x2i9WjJoxK7QKzAxUQFaNfgnC3iAgkUd9RTiWsmsaoXISLBQjnE4LvUjSEJMJHtGuhj72qHSSmfspOtHMAA0DoZ+v0Iz9u5FgT8rYc/Wkh9VYLvdS8r9eN1LDGydhfhgp6pO50DDiSAUojQINmKBE8VgDTATTXhEZY4GJ0oEtqBCSWpP6BEplMqM8kFSk14gXFXRo5nJEq6B1UTONmvl4WalfZfHlwRE4BlVggmtQBw+gAZqAgBi8gFfwBt/hB/yC3/PRHMx2ymCh4M8vGKOj7A==</latexit><latexit sha1_base64="oXbT6FHja3ovjDrv7pLA+hHCQIQ=">AAACLHicbVDLSgMxFE3qq9ZXa5dugkWoCHVGFN0IBUFcDVWmD2iHkknTNjTzIMkIw9Bvcasbv8aNiFu/w0w7C9t6IeFw7uMcjhtyJpVhfMLc2vrG5lZ+u7Czu7d/UCwdtmQQCUKbJOCB6LhYUs582lRMcdoJBcWey2nbndyl/fYzFZIFvq3ikDoeHvlsyAhWmuoXy7b1dGtb51b6VW3r7L5x2i9WjJoxK7QKzAxUQFaNfgnC3iAgkUd9RTiWsmsaoXISLBQjnE4LvUjSEJMJHtGuhj72qHSSmfspOtHMAA0DoZ+v0Iz9u5FgT8rYc/Wkh9VYLvdS8r9eN1LDGydhfhgp6pO50DDiSAUojQINmKBE8VgDTATTXhEZY4GJ0oEtqBCSWpP6BEplMqM8kFSk14gXFXRo5nJEq6B1UTONmvl4WalfZfHlwRE4BlVggmtQBw+gAZqAgBi8gFfwBt/hB/yC3/PRHMx2ymCh4M8vGKOj7A==</latexit><latexit sha1_base64="oXbT6FHja3ovjDrv7pLA+hHCQIQ=">AAACLHicbVDLSgMxFE3qq9ZXa5dugkWoCHVGFN0IBUFcDVWmD2iHkknTNjTzIMkIw9Bvcasbv8aNiFu/w0w7C9t6IeFw7uMcjhtyJpVhfMLc2vrG5lZ+u7Czu7d/UCwdtmQQCUKbJOCB6LhYUs582lRMcdoJBcWey2nbndyl/fYzFZIFvq3ikDoeHvlsyAhWmuoXy7b1dGtb51b6VW3r7L5x2i9WjJoxK7QKzAxUQFaNfgnC3iAgkUd9RTiWsmsaoXISLBQjnE4LvUjSEJMJHtGuhj72qHSSmfspOtHMAA0DoZ+v0Iz9u5FgT8rYc/Wkh9VYLvdS8r9eN1LDGydhfhgp6pO50DDiSAUojQINmKBE8VgDTATTXhEZY4GJ0oEtqBCSWpP6BEplMqM8kFSk14gXFXRo5nJEq6B1UTONmvl4WalfZfHlwRE4BlVggmtQBw+gAZqAgBi8gFfwBt/hB/yC3/PRHMx2ymCh4M8vGKOj7A==</latexit><latexit sha1_base64="oXbT6FHja3ovjDrv7pLA+hHCQIQ=">AAACLHicbVDLSgMxFE3qq9ZXa5dugkWoCHVGFN0IBUFcDVWmD2iHkknTNjTzIMkIw9Bvcasbv8aNiFu/w0w7C9t6IeFw7uMcjhtyJpVhfMLc2vrG5lZ+u7Czu7d/UCwdtmQQCUKbJOCB6LhYUs582lRMcdoJBcWey2nbndyl/fYzFZIFvq3ikDoeHvlsyAhWmuoXy7b1dGtb51b6VW3r7L5x2i9WjJoxK7QKzAxUQFaNfgnC3iAgkUd9RTiWsmsaoXISLBQjnE4LvUjSEJMJHtGuhj72qHSSmfspOtHMAA0DoZ+v0Iz9u5FgT8rYc/Wkh9VYLvdS8r9eN1LDGydhfhgp6pO50DDiSAUojQINmKBE8VgDTATTXhEZY4GJ0oEtqBCSWpP6BEplMqM8kFSk14gXFXRo5nJEq6B1UTONmvl4WalfZfHlwRE4BlVggmtQBw+gAZqAgBi8gFfwBt/hB/yC3/PRHMx2ymCh4M8vGKOj7A==</latexit>

<latexit sha1_base64="DWKTjoDAkGefFRmooqAXJjz2FT8=">AAACJXicbVDLSgMxFE3qq9ZXq0s3wSJUhDojim6EgiAuR+gL2rFk0kwbmkmGJCOU0v9wqxu/xp0IrvwVM+0sbPXChcO5j3M4QcyZNo7zBXMrq2vrG/nNwtb2zu5esbTf1DJRhDaI5FK1A6wpZ4I2DDOctmNFcRRw2gpGt+m89USVZlLUzTimfoQHgoWMYGOpR89r3tS9s0rdO73zTnrFslN1ZoX+AjcDZZCV1ytB2O1LkkRUGMKx1h3XiY0/wcowwum00E00jTEZ4QHtWChwRLU/mdmeomPL9FEolW1h0Iz9fTHBkdbjKLCbETZDvTxLyf9mncSE1/6EiTgxVJC5UJhwZCRKM0B9pigxfGwBJopZr4gMscLE2KQWVAhJrWn7AqUymVEuNVXpNxIlBRuauxzRX9A8r7pO1X24KNcus/jy4BAcgQpwwRWogXvggQYgQIFn8AJe4Rt8hx/wc76ag9nNAVgo+P0Dg6miMw==</latexit><latexit sha1_base64="DWKTjoDAkGefFRmooqAXJjz2FT8=">AAACJXicbVDLSgMxFE3qq9ZXq0s3wSJUhDojim6EgiAuR+gL2rFk0kwbmkmGJCOU0v9wqxu/xp0IrvwVM+0sbPXChcO5j3M4QcyZNo7zBXMrq2vrG/nNwtb2zu5esbTf1DJRhDaI5FK1A6wpZ4I2DDOctmNFcRRw2gpGt+m89USVZlLUzTimfoQHgoWMYGOpR89r3tS9s0rdO73zTnrFslN1ZoX+AjcDZZCV1ytB2O1LkkRUGMKx1h3XiY0/wcowwum00E00jTEZ4QHtWChwRLU/mdmeomPL9FEolW1h0Iz9fTHBkdbjKLCbETZDvTxLyf9mncSE1/6EiTgxVJC5UJhwZCRKM0B9pigxfGwBJopZr4gMscLE2KQWVAhJrWn7AqUymVEuNVXpNxIlBRuauxzRX9A8r7pO1X24KNcus/jy4BAcgQpwwRWogXvggQYgQIFn8AJe4Rt8hx/wc76ag9nNAVgo+P0Dg6miMw==</latexit><latexit sha1_base64="DWKTjoDAkGefFRmooqAXJjz2FT8=">AAACJXicbVDLSgMxFE3qq9ZXq0s3wSJUhDojim6EgiAuR+gL2rFk0kwbmkmGJCOU0v9wqxu/xp0IrvwVM+0sbPXChcO5j3M4QcyZNo7zBXMrq2vrG/nNwtb2zu5esbTf1DJRhDaI5FK1A6wpZ4I2DDOctmNFcRRw2gpGt+m89USVZlLUzTimfoQHgoWMYGOpR89r3tS9s0rdO73zTnrFslN1ZoX+AjcDZZCV1ytB2O1LkkRUGMKx1h3XiY0/wcowwum00E00jTEZ4QHtWChwRLU/mdmeomPL9FEolW1h0Iz9fTHBkdbjKLCbETZDvTxLyf9mncSE1/6EiTgxVJC5UJhwZCRKM0B9pigxfGwBJopZr4gMscLE2KQWVAhJrWn7AqUymVEuNVXpNxIlBRuauxzRX9A8r7pO1X24KNcus/jy4BAcgQpwwRWogXvggQYgQIFn8AJe4Rt8hx/wc76ag9nNAVgo+P0Dg6miMw==</latexit><latexit sha1_base64="DWKTjoDAkGefFRmooqAXJjz2FT8=">AAACJXicbVDLSgMxFE3qq9ZXq0s3wSJUhDojim6EgiAuR+gL2rFk0kwbmkmGJCOU0v9wqxu/xp0IrvwVM+0sbPXChcO5j3M4QcyZNo7zBXMrq2vrG/nNwtb2zu5esbTf1DJRhDaI5FK1A6wpZ4I2DDOctmNFcRRw2gpGt+m89USVZlLUzTimfoQHgoWMYGOpR89r3tS9s0rdO73zTnrFslN1ZoX+AjcDZZCV1ytB2O1LkkRUGMKx1h3XiY0/wcowwum00E00jTEZ4QHtWChwRLU/mdmeomPL9FEolW1h0Iz9fTHBkdbjKLCbETZDvTxLyf9mncSE1/6EiTgxVJC5UJhwZCRKM0B9pigxfGwBJopZr4gMscLE2KQWVAhJrWn7AqUymVEuNVXpNxIlBRuauxzRX9A8r7pO1X24KNcus/jy4BAcgQpwwRWogXvggQYgQIFn8AJe4Rt8hx/wc76ag9nNAVgo+P0Dg6miMw==</latexit>

False Positive Rate:
<latexit sha1_base64="FRD7PDjkPo2DTbhbR1H97kQ/7ao=">AAACH3icbVDLSgMxFE181vpqdekmWARXdUYU3QgFobiSUewD2qFk0kwbmkmGJCOUoT/hVjd+jTtx278x087Ctl4IHM59nJMTxJxp4zhTuLa+sbm1Xdgp7u7tHxyWykdNLRNFaINILlU7wJpyJmjDMMNpO1YURwGnrWB0n/Vbr1RpJsWLGcfUj/BAsJARbCzVrnvPd3Xv4rFXqjhVZ1ZoFbg5qIC8vF4Zwm5fkiSiwhCOte64Tmz8FCvDCKeTYjfRNMZkhAe0Y6HAEdV+OjM8QWeW6aNQKvuEQTP270aKI63HUWAnI2yGermXkf/1OokJb/2UiTgxVJC5UJhwZCTKfo/6TFFi+NgCTBSzXhEZYoWJsRktqBCSWdP2BMpkcqNcaqqyayRKijY0dzmiVdC8rLpO1X26qtSu8/gK4AScgnPgghtQAw/AAw1AAAdv4B18wE/4Bb/hz3x0DeY7x2Ch4PQX/dqgcw==</latexit><latexit sha1_base64="FRD7PDjkPo2DTbhbR1H97kQ/7ao=">AAACH3icbVDLSgMxFE181vpqdekmWARXdUYU3QgFobiSUewD2qFk0kwbmkmGJCOUoT/hVjd+jTtx278x087Ctl4IHM59nJMTxJxp4zhTuLa+sbm1Xdgp7u7tHxyWykdNLRNFaINILlU7wJpyJmjDMMNpO1YURwGnrWB0n/Vbr1RpJsWLGcfUj/BAsJARbCzVrnvPd3Xv4rFXqjhVZ1ZoFbg5qIC8vF4Zwm5fkiSiwhCOte64Tmz8FCvDCKeTYjfRNMZkhAe0Y6HAEdV+OjM8QWeW6aNQKvuEQTP270aKI63HUWAnI2yGermXkf/1OokJb/2UiTgxVJC5UJhwZCTKfo/6TFFi+NgCTBSzXhEZYoWJsRktqBCSWdP2BMpkcqNcaqqyayRKijY0dzmiVdC8rLpO1X26qtSu8/gK4AScgnPgghtQAw/AAw1AAAdv4B18wE/4Bb/hz3x0DeY7x2Ch4PQX/dqgcw==</latexit><latexit sha1_base64="FRD7PDjkPo2DTbhbR1H97kQ/7ao=">AAACH3icbVDLSgMxFE181vpqdekmWARXdUYU3QgFobiSUewD2qFk0kwbmkmGJCOUoT/hVjd+jTtx278x087Ctl4IHM59nJMTxJxp4zhTuLa+sbm1Xdgp7u7tHxyWykdNLRNFaINILlU7wJpyJmjDMMNpO1YURwGnrWB0n/Vbr1RpJsWLGcfUj/BAsJARbCzVrnvPd3Xv4rFXqjhVZ1ZoFbg5qIC8vF4Zwm5fkiSiwhCOte64Tmz8FCvDCKeTYjfRNMZkhAe0Y6HAEdV+OjM8QWeW6aNQKvuEQTP270aKI63HUWAnI2yGermXkf/1OokJb/2UiTgxVJC5UJhwZCTKfo/6TFFi+NgCTBSzXhEZYoWJsRktqBCSWdP2BMpkcqNcaqqyayRKijY0dzmiVdC8rLpO1X26qtSu8/gK4AScgnPgghtQAw/AAw1AAAdv4B18wE/4Bb/hz3x0DeY7x2Ch4PQX/dqgcw==</latexit><latexit sha1_base64="FRD7PDjkPo2DTbhbR1H97kQ/7ao=">AAACH3icbVDLSgMxFE181vpqdekmWARXdUYU3QgFobiSUewD2qFk0kwbmkmGJCOUoT/hVjd+jTtx278x087Ctl4IHM59nJMTxJxp4zhTuLa+sbm1Xdgp7u7tHxyWykdNLRNFaINILlU7wJpyJmjDMMNpO1YURwGnrWB0n/Vbr1RpJsWLGcfUj/BAsJARbCzVrnvPd3Xv4rFXqjhVZ1ZoFbg5qIC8vF4Zwm5fkiSiwhCOte64Tmz8FCvDCKeTYjfRNMZkhAe0Y6HAEdV+OjM8QWeW6aNQKvuEQTP270aKI63HUWAnI2yGermXkf/1OokJb/2UiTgxVJC5UJhwZCTKfo/6TFFi+NgCTBSzXhEZYoWJsRktqBCSWdP2BMpkcqNcaqqyayRKijY0dzmiVdC8rLpO1X26qtSu8/gK4AScgnPgghtQAw/AAw1AAAdv4B18wE/4Bb/hz3x0DeY7x2Ch4PQX/dqgcw==</latexit>

F1 score:
<latexit sha1_base64="wAnHsgPzVpqIMvwGn0tcKd2bo7Y="></latexit><latexit sha1_base64="wAnHsgPzVpqIMvwGn0tcKd2bo7Y="></latexit><latexit sha1_base64="wAnHsgPzVpqIMvwGn0tcKd2bo7Y="></latexit><latexit sha1_base64="wAnHsgPzVpqIMvwGn0tcKd2bo7Y="></latexit>

¿cuántos enfermos son correctamente 
detectados?
¿cuántos sanos no son seleccionados?

¿cuántos son los enfermos de los seleccionados? 

¿cuánto se acerca a los valores reales?

¿cuántos sanos son seleccionados?

Media armónica entre TPR y PPV.

enfermedadlogin
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k-means
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